### Documentation Accessibility

Chapter 1. Getting Started ............................................................ 7  
Overview ...................................................................................... 7  
Installing and Starting Predictive Planning .................................... 7  
The Predictive Planning Ribbon and Menus ................................. 8  
Running a Prediction .................................................................... 9

Chapter 2. Viewing Results .......................................................... 11  
Using the Predictive Planning Panel ............................................. 11  
Chart Tab .................................................................................... 12  
Data Tab ....................................................................................... 12  
Statistics Tab ............................................................................... 13  
Summary Area and Comments ..................................................... 14  
Setting Chart Preferences .......................................................... 15  
Using Comparison Views ............................................................ 16  
Editing the Current View ............................................................ 17  
Creating a New View .................................................................... 19  
Managing Views .......................................................................... 19

Chapter 3. Analyzing Results ......................................................... 21  
Overview ...................................................................................... 21  
Filtering Results .......................................................................... 21  
Pasting Results ............................................................................. 22  
Creating Reports ......................................................................... 23  
Setting Report Preferences .......................................................... 24  
Extracting Data ............................................................................ 25  
Setting Data Extraction Preferences ........................................... 25

Chapter 4. Setting General Predictive Planning Options ................. 27

Appendix A. Setting Up Predictive Planning .................................. 29  
Before You Begin ......................................................................... 29  
Assigning Security Roles ............................................................. 29  
Hierarchical Data Prediction Issues ............................................. 30  
Form Creation and Modification Issues ....................................... 31  
Setting Form Defaults ................................................................. 33  
Application and Individual Form Defaults .................................. 34  
Using the Set Up Form Dialog ...................................................... 35  
Specifying a Historical Data Source ............................................. 35
Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.
Overview

The Predictive Planning feature of Oracle Hyperion Planning is an extension to Oracle Smart View for Office that works with valid Planning forms to predict performance based on historical data. Predictive Planning uses sophisticated time-series and autoregressive integrated moving average (ARIMA) statistical techniques to confirm and validate predictions entered into Planning based on other prediction methods.

Predictive Planning is currently available in 32-bit and 64-bit implementations. Ad-hoc forms are not supported.

Note: Users with security roles that enable them to modify Planning forms should read Appendix A in this Guide to ensure that forms are configured for maximum compatibility.

Installing and Starting Predictive Planning

To install Predictive Planning, follow the instructions in the Oracle Hyperion Enterprise Performance Management System Installation and Configuration Guide.

To start Predictive Planning:

1. Confirm that compatible versions of Smart View, Predictive Planning, and Microsoft Excel are installed on your computer and that you have access to a compatible version of Planning.
2. Start Microsoft Excel.
3. In Smart View, connect to a source.
4. Open a valid Planning form, not ad hoc (“Using Valid Forms” on page 31).
5. Display the Predictive Planning ribbon:
In Microsoft Excel 2007 or later, select the Planning ribbon, and then click Predict.

In Microsoft Excel 2003, select Predict on the Predict menu.

The Predictive Planning Ribbon and Menus

When you start Predictive Planning in Microsoft Excel 2007 or later, the Predictive Planning ribbon is added to the ribbon bar (Figure 1 on page 8).

Figure 1  Predictive Planning Ribbon

Button groups are as follows:

- **Run**—Sets form preferences and runs predictions
- **View**—Displays and manages views of results
- **Analyze**—Filters and pastes results, creates reports, and extracts data to the spreadsheet
- **Help**—Displays online help and information about this version of Predictive Planning.

**Note:** If you have an appropriate license for Oracle Crystal Ball, select Help, and then Launch Crystal Ball to open Oracle Crystal Ball for simulation and optimization analysis (see http://www.oracle.com/crystalball for details).

A tooltip identifies each button when you point to it.

In Microsoft Excel 2003, the Predict menu offers similar commands (Figure 2).
For online help and information about Predictive Planning, select Help, and then Predictive Planning.

For a list of shortcut keys (keyboard equivalents of buttons and commands), see the Oracle Hyperion Planning Predictive Planning Accessibility Guide, or similar accessibility guide in the Planning and Budgeting Cloud Service.

**Running a Prediction**

When you run a prediction, Predictive Planning analyzes historical data for each selected member, and then projects this information into the future to generate predicted results.

To run a prediction:

1. Select Predict, or press Alt+y, p in Microsoft Excel 2007 or later (Alt+p, p in Microsoft Excel 2003).

2. Review the Run Confirmation dialog.

   It shows the number of members, the source and range of historical data to include in the prediction, and the predicted date range.

3. **Optional**: View or change included members and the historical or predicted date range.

   - By default, all editable members are selected. To change this, click Change and see “Selecting Members” on page 37.

   - By default, predictions are based on all historical data for a series. To select a specific data range for historical or predicted data, click Change and then specify a start and end year and time period.
Note: For the most accurate predictions, the number of periods of historical data available should be at least twice the number of prediction periods requested. If you have specified more prediction periods, you are prompted to reduce the number.

4 When the displayed settings are complete, click Run.

5 Review the Run Summary dialog, if present, and click OK.

Results are displayed in the Predictive Planning panel. By default, the Chart tab is selected (Figure 3 on page 12).
Viewing Results

In This Chapter

- Using the Predictive Planning Panel ................................................................. 11
- Setting Chart Preferences .............................................................................. 15
- Using Comparison Views ............................................................................... 16

Using the Predictive Planning Panel

Subtopics

- Chart Tab
- Data Tab
- Statistics Tab
- Summary Area and Comments

When you run a prediction in Predictive Planning, results are displayed in the Predictive Planning panel. These results are primarily used to compare Predictive Planning predictions with planners' forecasts. They can also be used to compare other types of predictions as well as values for various historical time series.

By default, a chart is displayed. You can also view data or statistics. For all views, the Member list determines which member is displayed. If you predicted results for more than one member, look at all results by selecting each member in the list. After you select a member, you can use the arrow keys to scroll up and down through the member list.

Note: Results charts are also called comparison views. For more information about displaying, editing, and creating them, see “Using Comparison Views” on page 16.

In Microsoft Excel 2007 and later, the Pin Panel button, 🔍, detaches the pane from the side panel. You can move the panel around the screen. Click the Pin Panel button again to attach it back to the side.

Note: If the Predictive Planning panel is hidden, select Panel in the Smart View ribbon to display it again.
Chart Tab

Predictive Planning results are displayed graphically on the Chart tab (Figure 3 on page 12).

Figure 3 Predictive Planning Panel, Chart Tab with Summary Area

The default view, Prediction, includes plots of historical and predicted data. The historical data series is displayed to the left of the vertical separator line. The predicted data series is bounded by dotted lines that show the upper and lower confidence intervals (labeled Worst Case and Best Case).

To change the appearance of a chart, double-click it or click the Chart Preferences button, (“Setting Chart Preferences” on page 15). You can use the Chart Scale button, to display a slider control that enables you to show more or less detail in the chart. You can also display a prediction fit line, a trend line (best fitting line), a growth rate line, or other scenario data from the application (“Editing the Current View” on page 17).

Data Tab

The Data tab shows a column for each data series displayed on the chart for the selected members (Figure 4 on page 13). In the default display, columns for the Worst Case and Best Case data series are also included. As in the Chart tab, the Data tab is split into past and future data sections. The future data section is shown at the bottom of the data table in bold font.
Note: Data values in the past section of the Fit & Forecast column are plotted as the prediction fit line when that data series is selected as part of editing a comparison view (“Adding Prediction Data” on page 18).

Figure 4 Predictive Planning Panel, Data Tab

Statistics Tab

The Statistics tab shows several statistics about historical data used to generate the prediction: number of values, minimum value, mean value, maximum value, standard deviation, and the period of seasonality if present (Figure 5 on page 14).

- **Number of data values**—The number of historical data values in the date range
- **Minimum**—The smallest value in the date range
- **Mean**—The average of a set of values, found by adding the values and dividing their sum by the number of values
- **Maximum**—The largest value in the data range
- **Standard deviation**—The square root of the variance for a distribution, where variance measures the degree of difference of values from the mean
- **Seasonality**—Whether the data has a detectable pattern (cycle) and, if so, the time period of that cycle
The table also displays the following:

- An accuracy value (calculated by subtracting the mean absolute percentage error, MAPE, from 100%)
- The current error measure used to select the best time-series forecasting method (the default is root mean squared error, RMSE); see “Time-series Forecasting Accuracy Measures” on page 49 for a list.
- The name of the best time-series forecasting method (“Classic Time-series Forecasting” on page 43, “ARIMA Time-series Forecasting Methods” on page 49)
- The parameters for that method (“Classic Nonseasonal Forecasting Method Parameters” on page 46, “Classic Seasonal Forecasting Method Parameters” on page 48)

For more information about accuracy, see “Summary Area and Comments” on page 14.

**Summary Area and Comments**

By default, the **Summary Area** is displayed below the results chart or table. It indicates whether the prediction was successful or whether a warning or error condition occurred instead. The Summary Area can be used with the Filter Results feature (“Filtering Results” on page 21) to provide a quick overview of the status of the various forecasts. If the prediction succeeded, an accuracy rating is displayed (see About Accuracy later in this topic for details). If results are filtered, messages indicate the filtering criteria currently in effect.

Comments are displayed next to each member in the form with success, warning, or error messages at the bottom of columns or end of rows.
About Accuracy

Statistically, the accuracy value is 100% minus the mean absolute percentage error (MAPE). Accuracy ranges from 0 to 100% and is 90% in the illustrated example. Ratings of 90 to 100% are considered Good, 80 to 90% are considered Fair, and 0 to 80% are considered Poor.

Notice that these ratings do not indicate whether the results of the member prediction are good or not within a planning context, only whether the quality of the prediction is good or not.

Accuracy indicates the ability of the prediction methods to pick up strong patterns in the historical data. If the data is very “noisy” with little pattern to it, the accuracy value is low. Data with regular and strong patterns has high accuracy values.

Accuracy is a relative measure that considers the magnitude of the prediction errors in relation to the range of the data. For example, the historical data may appear noisy and have apparently large prediction errors, but the peaks and valleys of the data along with the size of the prediction errors are small compared to the range of the data.

Setting Chart Preferences

To change the appearance of a chart in the Predictive Planning panel:

1. Double-click the chart or click the Chart Preferences button,
2. Select appropriate settings in the Chart Preferences dialog.
3. Optional: Select Reset to restore default settings.
4. Select OK when settings are complete.

Chart Preferences dialog settings are as follows, when selected:

- **Highlight seasonality**—Uses vertical bands to separate periods of cyclical data (years, months, and so on)
- **Highlight missing values and outliers**—Graphically emphasizes filled-in or adjusted-outlier data if these are present
- **Show separator between past and future data**—Displays a vertical line between historical and predicted data sections
- **Show current view name in chart**—Displays the name of the current view in the results chart
- **3D chart**—Adds a depth perspective to the chart without actually adding a third measured dimension
- **Transparency**—Reduces the intensity of chart colors by the indicated percentage to better show gridlines or other marks in charted areas
- **Gridlines**—Indicates whether lines should be displayed in the chart background, and, if so, whether they should be vertical, horizontal, or both.
Legend—Indicates whether a chart legend should be displayed, and, if so, whether it should be located to the right of, to the left of, or at the bottom of the chart, or whether the location should be automatically selected depending on panel size and orientation.

Note: Changing these settings affects only the appearance of charts on your local computer and does not affect the charts of other users.

Using Comparison Views

Subtopics

- Editing the Current View
- Creating a New View
- Managing Views

Predictive Planning is shipped with several predefined chart views:

- **Prediction**—Includes the historical data series, usually an Actual scenario, and the predicted future values based on those; the default
- **Scenario 1 vs. Prediction**—Compares data for a scenario mapped as Scenario 1 in the Set Up Form dialog with the predicted data; does not include the historical data series
- **Scenario 2 vs. Prediction**—Compares data for a second scenario mapped as Scenario 2 in the Set Up Form dialog with the predicted data; does not include the historical data series
- **Historical Scenario 1 vs. Historical Prediction**—Similar to **Scenario 1 vs. Prediction** but compares only historical values
- **Historical Scenario 1 vs. Historical Scenario 2**—Compares historical values for two scenarios mapped in the Set Up Form dialog

Notice that these predefined views may not be available if the associated scenarios have not been mapped in the Set Up Form dialog.

You can edit predefined or custom views, create new custom views, and manage views.

Note: Editing or creating views only affects the views on your local computer and does not affect the views of other users.
Editing the Current View

Subtopics

- Adding a Scenario
- Adding Prediction Data
- Adding a Trend Line

Note: You use very similar dialogs to edit the current view and create a new view, except that you can edit the name of a new view.

To edit the current view:

1. Select Edit Current View on the Predictive Planning ribbon or menu or right-click the tabbed portion of the Predictive Planning panel.

   Note: To create a new view, follow the instructions in “Creating a New View” on page 19. The New View dialog is identical to Edit View.

2. Select data series to show in the chart and clear the rest.

   Each data series in the view can include a Past section, which contains historical data, and a Future section which contains future predicted values or other forward-looking values. The point of time that separates the Past and Future sections is determined when you run a prediction. Prediction items are described in “Adding Prediction Data” on page 18).

3. Optional: Use the buttons to add scenarios (“Adding a Scenario” on page 17), prediction data series (“Adding Prediction Data” on page 18), and trend lines (“Adding a Trend Line” on page 18).

   Trend lines can be best fit lines through the historical data or lines based on a specified percentage of growth.

4. Optional: Click Remove to delete the selected item from the Data Series list and the view.

5. Optional: Use the arrow keys to change the order of selected items in the list, the lines on the chart, and the columns in the Data tab.

6. Optional: If you are creating a new view, either accept the automatically generated name or clear Auto, and then enter a new name in the View Name text box.

7. Click OK.

   Note: You can use Reset at any time to restore default settings to predefined views shipped with Predictive Planning.

Adding a Scenario

To add a scenario to a view:

1. In the Edit View or New View dialog, click Add Scenario (Alt+s).
2 In the Member Selection dialog, select a member from the Scenario dimension.

3 Optional: Select a member from the Version dimension, or leave Version members unselected to use the form's version.

4 Click OK.

Adding Prediction Data

To add prediction data to a chart view:

1 In the Edit View or New View dialog, click Add Prediction (Alt+p).

2 Select from among available prediction data series:
   - Prediction base case—Median prediction values calculated based on past historical data; median values mean that the actual values in the future are equally likely to fall above or below the base case values
   - Prediction worst case—A calculated lower confidence interval, by default the 2.5 percentile of the predicted range
   - Prediction best case—A calculated upper confidence interval, by default the 97.5 percentile of the predicted range
   - Prediction fit line—A line of the best fitting time-series forecasting method through the historical data

   If a prediction data series is already in the view, it is checked and not editable. You can remove the data series by selecting it in the Edit View or New View dialog and clicking Remove.

3 Click OK.

Adding a Trend Line

Trend lines on charts can be lines of best fit through historical data or growth rate lines that increase historical data by a specified percentage.

To add trend lines to a chart:

1 In the Edit View or New View dialog, click Add Trend Line (Alt+t).

2 In Add Trend Line, select Linear trend line or Growth rate.

   The sample chart shows the effect of your selection.

3 Optional: If you select Growth rate, specify the rate (2% is the default) and the time dimension (Year is the default). To compound growth by adding the previously calculated percentage to the current baseline value when calculating the next value, select Use compounding. By default, this setting is not selected.

4 Click OK.
Creating a New View

To create a new comparison view:

1. Select New View on the Predict ribbon or menu.

   The New View dialog opens with default settings based on the current view. This dialog is identical to the Edit View dialog, except that the View Name box is editable when Auto is cleared and a new view is created when you click OK.

2. Add or remove data series to create the new view as described in “Editing the Current View” on page 17.

3. Because each view must have a unique name, either accept the automatically generated name or clear Auto and enter a new name.

4. Click OK to save the new view.

Managing Views

To edit, rename, remove, or reorder any built-in or custom view:

1. Select Manage Views on the Predictive Planning ribbon or menu.

2. Select a view on the list and click the appropriate button:
   - Edit opens the Edit View dialog (“Editing the Current View” on page 17).
   - Rename opens the Rename View dialog. Enter a unique name and click OK.
   - Remove deletes the selected view without confirmation.

3. Optional: Use the arrow buttons to move the selected view to another position in the list. This changes the order of views in the Comparison Views menu.

4. Optional: Use the Reset button to restore ALL predefined views to their default states.
   - Warning! Using Reset permanently removes any custom views you created.

5. Click OK.
Overview

You can perform the following tasks to simplify analysis of Predictive Planning results:

- “Filtering Results” on page 21—Displaying subsets of results
- “Pasting Results” on page 22—Adding predicted data into Prediction scenarios
- “Creating Reports” on page 23—Displaying formatted results for selected members
- “Extracting Data” on page 25—Creating tables of predicted data in Smart View

Filtering Results

Filtering enables you to display only results that meet certain criteria. For example, you can set the criteria to show only members that have warning messages. The default is to show results for all members. When filtering criteria are changed, all open forms are updated:

- By default, member rows that do not meet the filtering criteria are collapsed to hide them. You can change this setting in the General Options dialog (Chapter 4, “Setting General Predictive Planning Options”).
- The member list in the Results View is changed to show only members that meet the filtering criteria and the view is updated.

Note: Filtering is a global setting. It applies to all forms and persists from one session to the next. If you save a filtered workbook and reopen it later, you can display hidden rows by performing a Refresh in Smart View.
To filter Predictive Planning results:

1. In the Analyze menu or ribbon group, select Filter Results.

2. In the Filter Results dialog, select a category:
   - **Prediction status**—The type of icon shown in the comments: Success, Warning, or Error
   - **Prediction accuracy**—Determined by a formula based on MAPE (mean absolute percentage error)
   - **Error measure** (RMSE, root mean squared error, MAPE, or MAD, mean absolute deviation)—The error measure to use for selecting the best time-series forecasting method, specified in the Set Up Form dialog.

3. Select a conditional operator: = (equal to), <> (not equal to), <= (less than or equal to), >= (greater than or equal to)

4. Select or enter a value. For Prediction accuracy, values range from 0%-100%; for Error measure, from 0 to +infinity or 0%-100%, depending on the selected measure.

5. **Optional:** Click Add Row to define another set of selection criteria. Multiple rows of criteria must all be satisfied to select a member (an AND operation).

6. Click OK to display members that meet the selected criteria.

**Note:** At any time, you can click Reset to remove all selected criteria and display results without filtering.

**Pasting Results**

Pasting results enables you to manually copy prediction results into a scenario on the form, for example a scenario named Forecast.

**Tip:** If you want to save prediction data for later comparisons without overwriting other scenarios, special Prediction scenarios must be added to the form by an administrator or other user who is able to modify Planning forms before you use Predictive Planning.

To paste prediction results into a scenario on the form:

1. Determine that a Prediction or other special scenario exists so you will not overwrite data in other scenarios.

2. Select one or more members to paste.
   - If you are using Microsoft Excel 2007 or later, click the bottom half of the Paste Results button and select from the listed options. (If you click the top half of Paste Results, the Paste Results dialog is displayed for the current member only; see step 3, following.)
   - If you are using Microsoft Excel 2003, select Paste Results in the Predictive Planning menu.
Select from the following:

- **Current Member**—Pastes results for only the member that is currently selected in Results View
- **All Members**—Pastes results for all predicted members; if present, filtering is ignored
- **Filtered Members**—When filtering is active, pastes results for the current set of filtered members
- **Selected Members**—Enables you to select members to paste

3 Select scenarios for pasting in the **Paste Results** dialog:

- **From**—Lists all series in the current view that are available for pasting; select the one whose data will be copied
- **To**—Lists all scenario/version combinations in the form; select the one to receive the pasted data
- **Prediction range**—Select the first setting to use the entire prediction range or select the second and specify how many periods of data to use

   **Note:** If the prediction range overlaps the data range on the form, only the dates shown on the form are pasted.

4 When settings are complete, click **OK**.

### Creating Reports

Predictive Planning reports can provide several kinds of information about predictions for selected members, including the run data and time, data attributes, run preferences, and the prediction results.

➢ To create a Predictive Planning report:

1 In the **Analyze** menu or group, select **Create Reports**.

2 In the **Create Report** dialog, select one of the following:

   - **All members**—Shows report information for all predicted members
   - **Filtered members**—If available, shows information for all members that are not excluded by filters
   - **Selected members**—Displays a dialog for member selection

3 Optional: Click **Preferences** to customize the contents of the report (“**Setting Report Preferences**” on page 24).

4 When settings are complete, click **OK**.
Setting Report Preferences

“Creating Reports” on page 23 describes how to generate a basic Predictive Planning report. Report preferences enable you to customize reports.

To set report preferences:

1. In the Create Report dialog, click Report Preferences.
2. On the Report tab of the Report Preferences dialog, in the Report sections list, select Report Summary to review and, optionally, modify the display selections:
   - Report title—Displays a default report title
   - Run date/time—The date and time the report was created
   - Data attributes—The number of members and other descriptors including the historical data source
   - Run preferences—The number of periods to forecast, whether missing values are filled in, whether outliers are adjusted, prediction methods used, and the selected error measure
   - Prediction results—A summary of the predicted values
3. In the Report sections list, select Members to review and, optionally, modify the selections:
   - Chart—Includes the results chart at the indicated percent of default size
   - Predicted values—Values for each time period in the prediction range
   - Statistics—Information included in the Statistics tab (“Statistics Tab” on page 13)
   - Methods—The number of time-series forecasting methods reported: all methods used, the three best methods, the two best methods, or only the best method, where “best” is defined as the most accurate
4. On the Options tab of the Report Preferences dialog, review and, optionally, modify the following settings:
   - Location—Whether to create the report in a new Microsoft Excel workbook or the current workbook; if you select Current workbook, a new sheet is created after the current sheet
     You can enter a name for the new sheet in the Sheet Name text box.
   - Formatting—Whether to include cell locations (workbook, worksheet, and cell address) in report headers (selected by default)
   - Chart format—Whether to create a native Predictive Planning chart (Image) or a Microsoft Excel chart
     If you select Image, you can format charts using the Predictive Planning Chart Preference settings (“Setting Chart Preferences” on page 15).
5. When all settings are complete, click OK.
Extracting Data

You can extract results and methods from the current Predictive Planning forecasting run.

To extract results:

1. In the Analyze menu or group, select Extract Data.
2. In the Extract Data dialog, select one of the following:
   - **All members**—Shows report information for all predicted members
   - **Filtered members**—If available, shows information for all members that are not excluded by filters
   - **Selected members**—Displays the Smart View dialog for member selection
3. Optional: Click Preferences to select which data to extract (“Setting Data Extraction Preferences” on page 25).
4. When settings are complete, click OK.

Setting Data Extraction Preferences

“Extracting Data” on page 25 describes how to extract basic Predictive Planning results to a workbook in tabular form. Data extraction preferences enable you to customize which results to extract.

To set data extraction preferences:

1. In the Extract Data dialog, click Preferences.
2. On the Data tab of the Extract Data Preferences dialog, select the type of data to extract:
   - **Results Table**—Extracts past or future values, or both, for the members selected for data extraction
   - **Methods Table**—Lists the best time-series forecasting methods plus any of the following statistical data and information about the forecasting methods used:
     - **Accuracy**—An estimate of the accuracy of predicted results
     - **Errors**—Error statistics for predicted results (RMSE, MAD, and MAPE)
     - **Parameters**—Displays calculated parameters for the basic forecasting methods and transformational lambda and BIC results for ARIMA methods
     - **Ranking**—Indicates the prediction ranking of displayed methods, where 1 is best
3. On the Options tab, review and, optionally, modify the following:
   - **Location**—Indicates whether to write results to a new workbook or the current workbook, and the sheet names to use for the Results table and Methods table
   - **Formatting**—Indicates whether to automatically format results (AutoFormat selected)
4. When all settings are complete, click OK.
Appendix A, “Setting Up Predictive Planning” describes how administrators (and other users whose security roles enable them to modify Planning forms) can set up Planning and its Predictive Planning feature for efficient and effective use. This chapter describes how other users can customize Predictive Planning for individual sessions without modifying forms.

To change general Predictive Planning option settings:

1. Select **Options** in the Predictive Planning menu or ribbon.
2. Review and, optionally, change **General options**:
   - **Show ribbon only for valid Planning forms**—When selected, hides the Predict ribbon in Microsoft Excel 2007 unless a valid form is open; default is selected.
   - **Show prediction comments next to the form**—Depending on the orientation of the form, shows prediction comments either beside or below members in the form; default is selected.
   - **Collapse rows and columns on form during filter operations**—When selected, “hides” excluded members by collapsing their rows or columns; default is selected.
   - **Reset** button for “Do not show” checkboxes—When clicked, clears any checkboxes that were selected to prevent the repetitive display of message boxes, prompts, and other information where “Do not show” checkboxes are offered.
3. Review and, optionally, change **Date formatting options**:
   - **Format**—Indicates whether the period or year is displayed first in date labels; default is **Period-Year**.
   - **Separator**—Indicates whether to use -, /, or a blank space to separate the period and year; default is -.  
4. **Optional:** Select **Enable accessibility options** to activate Predictive Planning features for users with visual impairments, including the use of patterns instead of colors.

For a description of accessibility features, including keyboard command equivalents, see the Oracle Hyperion Planning Predictive Planning Accessibility Guide, or similar accessibility guide in the Planning and Budgeting Cloud Service.

5. When settings are complete, **click OK**.

**Note:** You can click **Reset** at any time to restore default settings.
Before You Begin

Subtopics

- Assigning Security Roles
- Hierarchical Data Prediction Issues
- Form Creation and Modification Issues

Note: This appendix is for administrators and other users whose security roles enable them to modify Planning forms.

Predictive Planning is a Planning feature that works within Smart View to predict future results from historical data. It is easy to use but requires some administrative setup.

This section describes Predictive Planning requirements and explains concepts that are important when setting Planning form defaults for use with Predictive Planning. While factory defaults are available, forms should be set up with application defaults at a minimum; some forms might also require individual defaults.

For most efficient setup, review the topics listed at the beginning of this section first, and then set application and individual defaults (“Setting Form Defaults” on page 33).

Assigning Security Roles

Predictive Planning users must be assigned roles that enable them to use Planning and to be an ad hoc user. Roles are assigned using Oracle Identity Management. Only those with the ability to modify forms can use the Set Up Form dialog to define Predictive Planning defaults.
Hierarchical Data Prediction Issues

Subtopics

- Comparing Bottom-up and Top-down Forecasting
- Pasting Results for Forecasting
- Aggregating Best and Worst Case Predictions
- Historical Data and Forecasting Accuracy

Planning data is structured in a hierarchy of levels, from the most general categories to the most detailed. Knowledge of important concepts in this section will help when working with the Member Selection dialog and other setup features.

Comparing Bottom-up and Top-down Forecasting

Bottom-up forecasting involves predicting members at the lowest levels of the dimension hierarchies and optionally rolling up the results to higher level summary members.

Top-down forecasting involves predicting members at the summary levels of the dimension hierarchies and optionally spreading the results down to lower level members. This type of forecasting is useful when historical data is not available for lower level members, or when top level predictions are being used to “drive” the results down to lower members.

Note: Forecasting results between bottom-up and top-down methods should be close, but predictions on lower level members are the most accurate since the individual trends and patterns of the data are preserved in the prediction process.

Pasting Results for Forecasting

To roll up (or spread down) results, users need to paste the predicted values into the form, and then submit the form. This recalculates the Planning business logic and propagates the predicted results accordingly. To simplify the pasting of predicted values by users, you can set up automatic pasting for the form (“Mapping Member Names” on page 36).

Caution! If users will be pasting results, either manually or automatically, a scenario must be added to the form to hold the pasted results. For example, a Prediction scenario could be added. Otherwise, the pasted results could overwrite other scenarios. For more information, see “Creating a New Scenario for Prediction Results” on page 33.

Aggregating Best and Worst Case Predictions

The best and worst case predictions (by default, the 2.5% and 97.5% percentiles of the predicted values) are automatically generated. These values can be saved in Planning, but are not easy to roll up or spread down because of the complexity of their aggregation. Rolling them up or spreading them down requires custom formulas to be added to the Planning business logic.
While closed-form formulas are available for addition and subtraction, they do not exist for some cases of aggregation (for example, division).

**Historical Data and Forecasting Accuracy**

The amount of historical data available determines the accuracy and quality of the forecasts; the more data the better. There should be at least twice the amount of historical data as the number of prediction periods. If not enough historical data is available at the time of prediction, a warning or error is displayed. Predictive Planning can detect seasonal patterns in the data and project them into the future (for example, spikes in sales numbers during holiday seasons). At least two complete cycles of data must be available to detect seasonality.

In addition, Predictive Planning detects missing values in the historical data, filling them in with interpolated values, and scans for outlier values, normalizing them to an acceptable range. If there are too many missing values or outliers in the data to perform reliable predictions, a warning or error message is displayed.

**Form Creation and Modification Issues**

Subtopics

- Using Valid Forms
- Determining the Time Granularity of Predictions
- Determining the Prediction Range
- Creating a New Scenario for Prediction Results

Certain aspects of form structure affect the performance of Predictive Planning, as described in the listed topics.

**Using Valid Forms**

Forms must be validated before Predictive Planning can be used with them. In general, a valid Planning form must have the following:

- A series axis, containing one or more non-time dimensions, such as Account or Entity. Year or Period dimensions are only allowed on the time axis.
- A time axis, containing the Year or Period dimensions, or both. The Year and Period dimensions must appear on one (and only one) axis.
- Scenario and Version dimensions are permitted on either axis.
- The form must not be empty.
- The form must not be ad hoc.
Determining the Time Granularity of Predictions

The lowest Period dimension member level on a form determines the time granularity of the prediction. That is, if the lowest member level is Quarters (Qtr1, Qtr2, on so on), then historical data is retrieved at the Quarters level and the prediction will also take place at the Quarters level. For this reason, it is important to include on the form the lowest level of Period members possible so that the greatest amount of historical data can be used.

In Figure 6 on page 32, Quarters are the lowest level members of the Period dimension that appear on the form. You can tell this by the fact that the "Q1" name does not have a "+" symbol by it. If it did, this would mean that lower level members (such as months) exist on the form but are hidden from view by collapsing the columns. If the form included the Months levels (even if hidden), then Predictive Planning would predict at the Months level. For purposes of determining time granularity, it does not matter if the members are hidden or visible on the form.

Determining the Prediction Range

The prediction range starts one period after the end of historical data for all members on the form, regardless of the starting date of the form. If the members do not all have the same amounts of historical data, the end of historical data (and thus the start of the prediction range) will be determined by those members that have the greatest amount of similar historical data. These dates can be overridden by the user at the start of a prediction. By default, the end date on the
form determines the end date of the prediction. This can also be overridden by users at the start of a prediction.

Note: The prediction range end date is also limited to the members defined for Year and Period. That is, if the last Year-Period defined is 2015-Dec, then it is not possible to predict past this date. This limit is independent of the end date on the form itself. If users are having trouble predicting too far into the future and are receiving error messages, more time periods must be defined in the Planning application.

Creating a New Scenario for Prediction Results

After a prediction runs, users can paste the results to a form and save them. Typically, users may want to save prediction results to a Forecast or Plan scenario. However, if users want to keep the prediction results separate from these types of scenarios, you will need to add a special scenario to Planning (for example, “Prediction”) to hold those results without overwriting other scenarios. You can also create additional scenarios to store the best and worse case prediction results as well. These scenarios should then be mapped appropriately in the Set Up Forms dialog (“Mapping Member Names” on page 36). For additional discussion, see “Pasting Results for Forecasting” on page 30 and “Aggregating Best and Worst Case Predictions” on page 30.

Note: Members that are read-only on the form can still be predicted, but the results cannot be pasted back into the member rows or columns.

Setting Form Defaults

Subtopics

- Application and Individual Form Defaults
- Using the Set Up Form Dialog
- Specifying a Historical Data Source
- Mapping Member Names
- Selecting Members
- Setting Prediction Options
- Using Alternate Historical Data Sources

Setting up a form for use with Predictive Planning defines application or individual defaults for that form. Some of the settings require Planning knowledge, while others require a basic knowledge of classic and ARIMA time-series forecasting. Once a form has been set up, users should be able to open the form in Oracle Smart View for Office, start Predictive Planning, and immediately run a prediction using the defaults.
Tip: If other defaults are not available, factory defaults are applied to all forms used with Predictive Planning. If customized defaults are required, application defaults can automate that process at an application level, while individual defaults override other defaults on a particular form. For best results, read this entire section, particularly “Application and Individual Form Defaults” on page 34, before setting any Predictive Planning defaults.

Note: You must have a security role that enables you to modify Planning forms to define defaults.

Caution! Form defaults (preferences) set for previous Predictive Planning versions 11.1.2.2.000 and 11.1.2.2.300 are used in version 11.1.2.3.000. However, form defaults set in Predictive Planning version 11.1.2.3.000 are not usable in previous versions 11.1.2.2.000 and 11.1.2.2.300. Using different versions of Predictive Planning with the same server can cause the loss of preference settings. This information does not apply to users of Oracle Planning and Budgeting Cloud Service.

**Application and Individual Form Defaults**

When a form is first opened in Predictive Planning, it receives factory defaults for all Predictive Planning settings (that is, all of the settings that appear in the Set Up Form dialog). You will probably want to override some of these settings and create an application-level default for all forms, or individually customize the default settings for selected forms. The application default settings are stored in the Planning application and are applied to all forms when they are opened. Individual defaults are stored with the form to which they are applied.

Tip: Set the application-level default for all forms first, and then customize the default for individual forms as needed.

To set application-level defaults:

1. Open any form.
2. Customize the settings in the Set Up Form dialog.
3. Click **Set Default**.
   
   All settings on all tabs of the Set Up Form dialog are immediately saved as application defaults for all forms.
4. Press **Cancel** to avoid setting an individual-level default for the current form.

To set individual-level defaults:

1. Open a form and customize the settings in the Set Up Form dialog.
2. Click **OK** to save all settings on all tabs as individual defaults.
   
   Whenever that form is opened, all the settings are applied and override any application-level defaults.
When forms are opened by users, the form first receives any individual-level default settings, if an individual default was created, and then receives application-level defaults.

**Using the Set Up Form Dialog**

The **Set Up Form** dialog is used to do the following:

- Select the source of historical data on which to base predictions ("Specifying a Historical Data Source" on page 35)
- Map Predictive Planning names to members ("Mapping Member Names" on page 36)
- Specify which members on a form to predict ("Selecting Members" on page 37)
- Select and override various prediction option settings ("Setting Prediction Options" on page 38)

➢ To open the **Set Up Form** dialog, select **Set Up Form**, in the Predictive Planning ribbon or menu.

**Specifying a Historical Data Source**

When you specify a historical data source, you select where the historical data will be coming from and indicate whether to use all historical data or only data from a specified date range.

**Note:** Administrators and other users with appropriate security roles can define and use alternate data sources instead of or in addition to the default data source for the current Planning application ("Using Alternate Historical Data Sources" on page 40).

➢ To specify a source for historical data:

1. Open the **Set Up Form** dialog.
2. On the **Data Source** page, select a **Plan Type**:

   - **PlanName** (Default Plan) is the Plan Type associated with the current form. Select this plan type to use any historical data contained within this application (the default).

   - **OtherPlanNames**, if available, are alternate plan types provided by the data administrator as sources of historical data. These are typically Aggregate Storage Option (ASO) applications.

3. Indicate whether to **Use all historical data** or a **Selected date range**.

   **Note:** When they run predictions, users will be able to temporarily override the selected date range using the **Change Date** buttons on the **Run Confirmation** dialog.

4. **Optional:** If you selected **Selected date range**, specify a start and end year and time period.
Note: For a discussion of the date range, see “Determining the Prediction Range” on page 32.

5 Optional: Set or reset defaults using one of the following selections:

- Click Set Default to store settings on all tabs as application defaults.
- Click OK to store settings on all tabs as individual defaults for only this form.
- Click Reset at any time to restore the predefined defaults shipped with Predictive Planning or application defaults set with Set Default. This resets ALL tabs of the dialog.

Note: For more information about defaults, see “Application and Individual Form Defaults” on page 34.

6 Optional: To leave the dialog without changing defaults, click Cancel.

Mapping Member Names

Use Map Names to identify key scenarios in the application and link them to Predictive Planning data series. Predictive Planning uses the historical data series to generate predictions for each member on the form. Comparison data series can be set up to compare predicted results to forecast scenarios, budget scenarios, and so on. Prediction data series can be set up to hold prediction results in a separate area in the application. For details, see “About Name Defaults” on page 37.

To map member names to specific Predictive Planning data series:

1 Open the Set Up Form dialog.

2 On Map Names, select the following:

- Historical data series group, Scenario—The dimension member name to use as the historical data series to generate the prediction; a required selection
- Comparison data series group, Scenario 1 and Scenario 2—Additional dimension member names to compare with the historical data series in comparison charts; selecting one or both scenarios in this group is optional
- Prediction data series group, Base case scenario, Worst case scenario, and Best case scenario—Optional scenarios that must be created in Planning forms by administrators or other users whose security roles enable them to modify Planning forms; used to hold predicted values when pasted into the form

To select a member, click the ... button, and then select members from the Scenario and Version dimensions. If you do not select a Version member, the current Version member on the form is used. If there are more than one Version members on the form, the first Version member is used.

3 Optional: When a Comparison data series or Prediction data series member is selected, an X button is displayed next to it. You can use this button to clear the selection and restore the list to its default, <None>.
Because the Historical data series member is required, you can not clear it and can only select another member.

4 Optional: Select Automatically paste results to prediction scenarios to paste results after each prediction ("Pasting Results" on page 22).

Note: When pasting, the form must contain a scenario to hold the pasted results to avoid overwriting other scenarios.

5 Optional: Set or reset defaults using one of the following selections:
   - Click Set Default to store settings on all tabs as application defaults.
   - Click OK to store settings on all tabs as individual defaults for only this form.
   - Click Reset at any time to restore the predefined defaults shipped with Predictive Planning or application defaults set with Set Default. This resets ALL tabs of the dialog.

Note: For more information about defaults, see “Application and Individual Form Defaults” on page 34.

6 Optional: To leave the dialog without changing defaults, click Cancel.

About Name Defaults

The Map Names panel on the Set Up Form dialog is used to identify Predictive Planning key scenarios on the form. The only required mapping identifies which scenario holds the historical data series; the default is “Actual ([current])”. You will need to change this default if the historical data scenario is something other than “Actual”, or if the version for this scenario is different from the form’s version. To make it easier for users to compare predicted results to other scenarios like Forecast or Plan, you can map these scenarios in the Comparison data series section.

When users open the form, several additional views automatically appear in the Comparison Views menu, and users can select from among these comparisons. If you do not map the comparison data series, users can always create custom comparison views manually using the Edit Current View and New View commands. Manually created views are stored only on the user’s computer. If you add special scenarios to Planning to hold prediction results, you should map these scenarios in the Prediction data series section. For instructions, see “Mapping Member Names” on page 36.

Selecting Members

Use Member Selection to determine which form members to select for prediction. “Bottom-up” predictions, the default, choose members at the lowest level of the hierarchy for forms built to aggregate results up to higher level members. “Top-down” predictions choose members at the highest level of the hierarchy for forms built to push results down to lower level members. Full predictions choose all members on the form. Optionally, you can skip any read-only members.
To indicate which members on a form to include in a prediction:

1. Open the **Set Up Form** dialog.

2. On **Member Selection**, select a prediction type:
   - **Bottom-up (lowest level members only)**—Includes only the lowest level members in the hierarchy included on the form, the lowest level for each dimension if multiple dimensions are included; the default
   - **Top-down (highest level members only)**—Includes only the highest level members in the hierarchy included on the form, the highest level for each dimension if multiple dimensions are included
   - **Full (all members)**—Predicts all members regardless of their hierarchy level

3. **Optional**: Select **Skip 'read only' members**, which includes only members with writable (editable) cells in the prediction. Members with read-only cells typically include calculated summary data that is stored in the dimension hierarchy.

4. **Optional**: Set or reset defaults using one of the following selections:
   - Click **Set Default** to store settings on all tabs as application defaults.
   - Click **OK** to store settings on all tabs as individual defaults for only this form.
   - Click **Reset** at any time to restore the predefined defaults shipped with Predictive Planning or application defaults set with **Set Default**. This resets ALL tabs of the dialog.

   *Note:* For more information about defaults, see “Application and Individual Form Defaults” on page 34.

5. **Optional**: To leave the dialog without changing defaults, click **Cancel**.

### Setting Prediction Options

The prediction options specify data attributes, prediction methods, and other aspects of time-series analysis performed by Predictive Planning. The defaults are suitable for most predictions and should only be changed by those with some knowledge of time-series analysis.

1. Open the **Set Up Form** dialog.

2. On **Options**, review and select from the following:
   - **Data attributes** group:
     - Select whether to detect seasonality (regular cycles of data) automatically (**Automatic**, the default) or manually (**Manual**). If you select **Manual**, specify the
number of time periods per cycle. For example, if time periods are quarters with a yearly cycle, there would be 4 periods per cycle.

- Select whether to Fill in missing values and Adjust outliers. These settings estimate missing data based on adjacent data and help to normalize unusual data.

**Note:** Fill-in Missing Values uses interpolation to fill in gaps in the historical data. Clearing this option skips prediction calculation for members with gaps in their data.

Adjust Outliers uses a special fitting algorithm to determine whether data points fall within a reasonable range compared to all the other data points for a member. Clearing this option still allows the prediction to proceed, although the prediction algorithm may be thrown off by the outlier data points.

- **Prediction methods** group:
  - Select which time-series prediction methods to use: Nonseasonal (does not fit to cyclical data), Seasonal (fits to cyclical data), or ARIMA (both nonseasonal and seasonal using predefined statistical models). See “Classic Time-series Forecasting” on page 43 and “ARIMA Time-series Forecasting Methods” on page 49 for lists and details.

  Select all three, the default, unless you have a good reason to do otherwise.

  - Select an error measure to use in selecting the best method: RMSE, MAD, or MAPE (“Time-series Forecasting Accuracy Measures” on page 49).

    Again, use the default, RMSE, unless you have a good reason to use another.

- **Prediction periods** group:
  - Select whether to detect periods automatically, Select periods based on form, or manually, Manual. If you select Manual, specify the number of periods to predict. Generally, the number of prediction periods should be less than half the amount of actual data.

  - Select a Prediction interval, which defines a range around the base predicted value where the value has some probability of occurring; for example, the default (2.5% and 97.5%) means that there is a 95% probability that the predicted value will fall between the 2.5 percentile and the 97.5 percentile.
Note: Prediction Interval determines the percentile range around the base case prediction that is used to represent the best and worst case predictions. For example, a 2.5% - 97.5% prediction interval estimates that 95% of the time the predicted value will actually occur between the lower and upper bounds; 5% of the time the value will lie outside of these bounds.

These lower and upper percentile values are also used to indicate the worst and best case predicted values. For a Revenue-type account member, the worst and best cases are assigned to the lower and upper percentile values, respectively. For an Expense-type account member, the cases are reversed; the best case is associated with the lower bound (e.g. 2.5%) and the worst case is associated with the upper bound (e.g. 97%).

3 Optional: Set or reset defaults using one of the following selections:

- Click Set Default to store settings on all tabs as application defaults.
- Click OK to store settings on all tabs as individual defaults for only this form.
- Click Reset at any time to restore the predefined defaults shipped with Predictive Planning or application defaults set with Set Default. This resets ALL tabs of the dialog.

Note: For more information about defaults, see “Application and Individual Form Defaults” on page 34.

4 Optional: To leave the dialog without changing defaults, click Cancel.

Using Alternate Historical Data Sources

Subtopics

- Alternate Plan Types and POV Configuration
- Alternate Plan Types and Dates

“Specifying a Historical Data Source” on page 35 describes how to specify a source for the historical data used to predict future results. You select the source in the Plan Type box.

The default plan type is the plan associated with the current form, but administrators and others with appropriate security roles can define and use alternate plan types as historical data sources. For example, an administrator can create an ASO Plan Type for historical data, since this type supports efficient storage and access to large amounts of data (“Alternate Plan Types and Dates” on page 41).

Note: Alternate plan types can contain data for dates that are earlier than those included in the default plan type (“Alternate Plan Types and Dates” on page 41).

If alternate plans types are available, you can select them for use in the Data Source panel. If you select an alternate plan type, the upper part of the Data Source panel includes additional controls:
Configure POV button—Opens the Member Selection dialog, where you can add members that are unmatched in the alternate plan type point of view (POV). See “Alternate Plan Types and POV Configuration” on page 41.

Warning icon—Clicking this icon, 🚸, or pressing the spacebar while it is selected displays a detailed message about POV issues to help identify unmatched members for configuration.

Consolidate with default plan type checkbox—When selected, this setting indicates that historical data is taken from the alternate plan type first and then from the default plan type. With consolidation, data overlaps or gaps are evaluated for each data series. In case of overlap, data from the two data sources are merged. Data from the alternate plan type overrides any data from the default plan type for the same date location. If there is a gap between the data sets, missing values are estimated and filled in when a prediction is run. When Consolidate with default plan type is not selected, historical data is read only from the alternate plan type.

Alternate Plan Types and POV Configuration

If the point of view for the current form can not be matched to the alternate plan type, an error message and a warning icon are displayed. You can click the icon to learn more about the detected mismatch. For example, a member in the POV may not be present in the alternate plan type and must be configured.

➢ To configure the POV:

1 Click Configure POV.

2 In the Member Selection dialog, locate the unmatched member in the first panel from the left.

3 Select the value to add and then click the right-arrow in the center of the screen to move it into the second panel.

4 When all unmatched members have values, click OK.

Alternate Plan Types and Dates

Subtopics

- About Alternate Year Dimensions
- Alternate Year Dimension Requirements
- About Creating Alternate Plan Types

On reason for defining and using alternate plan types is to enable the use of historical date ranges that are earlier than those in the default plan type.

The historical data source, whether default or alternate, must contain all the dimensions on either the Series or Time axis of the current Planning form. One exception is that an alternate year dimension can be specified for the Year dimension. This is useful when an alternate plan type contains earlier dates than the default.
**About Alternate Year Dimensions**

An alternate year dimension may be used for a historical plan type which contains years prior to the start of the current Year dimension. This approach enables the addition of past historical years if the current Planning application’s Year dimension does not include enough past years to meet prediction requirements. For example, if the current Year dimension covers FY08 to FY14, it may be necessary to add historical data from FY03 to FY07 for predictions. In this case, a historical plan type may be used with an alternate year dimension that contains members FY03 to FY07. The dimension name may be any valid custom dimension name, such as AltYear. For dimension requirements, see “Alternate Year Dimension Requirements” on page 42.

**Alternate Year Dimension Requirements**

Alternate year dimensions must meet the following requirements:

- The alternate year dimension is a custom Planning dimension with year members that follow the same naming pattern as the current Year dimension. For example, if the Year dimension contains FY08 to FY14, then the alternate year dimension should use FYxx as the naming pattern, such as FY03 to FY07.
- The application’s Year dimension cannot be included in this alternate historical plan type.
- When an alternate plan type is selected as a data source and an alternate year dimension is present, the alternate year dimension will be detected automatically. A dialog is displayed that asks users if they want to use the alternate year dimension. If they respond OK, the alternate year dimension is used.

For additional information about creating alternate plan types, see “About Creating Alternate Plan Types” on page 42.

**About Creating Alternate Plan Types**

Alternate plan types containing alternate year dimensions typically are created after the initial creation of a Planning application. They usually use the ASO storage type as this type is more efficient for large amounts of data. All plan types created during the initial Oracle Hyperion Planning application creation typically inherit the Year dimension. However, ASO plan types created after the application enable administrators and others with appropriate security roles to add dimensions selectively so that a custom year dimension can be included without the default Year dimension.
The topics in this section are for those who want to know more about the forecasting methods and error measures used in Predictive Planning.

**Classic Time-series Forecasting**

**Subtopics**

- Classic Nonseasonal Forecasting Methods
- Classic Seasonal Forecasting Methods

Two primary techniques of classic time-series forecasting are used in Predictive Planning:

- "Classic Nonseasonal Forecasting Methods" on page 44 — Estimate a trend by removing extreme data and reducing data randomness
- "Classic Seasonal Forecasting Methods" on page 46 — Combine forecasting data with an adjustment for seasonal behavior

For information about autoregressive integrated moving average (ARIMA) time-series forecasting, see “ARIMA Time-series Forecasting Methods” on page 49.
Classic Nonseasonal Forecasting Methods

Subtopics

- Single Moving Average (SMA)
- Double Moving Average (DMA)
- Single Exponential Smoothing (SES)
- Double Exponential Smoothing (DES)
- Classic Nonseasonal Forecasting Method Parameters

Nonseasonal methods attempt to forecast by removing extreme changes in past data where repeating cycles of data values are not present.

**Single Moving Average (SMA)**

Smoothes historical data by averaging the last several periods and projecting the last average value forward.

This method is best for volatile data with no trend or seasonality. It results in a straight, flat-line forecast.

**Double Moving Average (DMA)**

Applies the moving average technique twice, once to the original data and then to the resulting single moving average data. This method then uses both sets of smoothed data to project forward.

This method is best for historical data with a trend but no seasonality. It results in a straight, sloped-line forecast.
**Single Exponential Smoothing (SES)**

Weights all of the past data with exponentially decreasing weights going into the past. In other words, usually the more recent data has greater weight. Weighting in this way largely overcomes the limitations of moving averages or percentage change methods.

This method, which results in a straight, flat-line forecast is best for volatile data with no trend or seasonality.

**Double Exponential Smoothing (DES)**

Applies SES twice, once to the original data and then to the resulting SES data. Predictive Planning uses Holt’s method for double exponential smoothing, which can use a different parameter for the second application of the SES equation.

This method is best for data with a trend but no seasonality. It results in a straight, sloped-line forecast.
Classic Nonseasonal Forecasting Method Parameters

The classic nonseasonal methods use several forecasting parameters. For the moving average methods, the formulas use one parameter, period. When performing a moving average, Predictive Planning averages over a number of periods. For single moving average, the number of periods can be any whole number between 1 and half the number of data points. For double moving average, the number of periods can be any whole number between 2 and one-third the number of data points.

Single exponential smoothing has one parameter: alpha. Alpha (a) is the smoothing constant. The value of alpha can be any number between 0 and 1, not inclusive.

Double exponential smoothing has two parameters: alpha and beta. Alpha is the same smoothing constant as described above for single exponential smoothing. Beta (b) is also a smoothing constant exactly like alpha except that it is used during second smoothing. The value of beta can be any number between 0 and 1, not inclusive.

Classic Seasonal Forecasting Methods

Subtopics

- Seasonal Additive
- Seasonal Multiplicative
- Holt-Winters’ Additive
- Holt-Winters’ Multiplicative
- Classic Seasonal Forecasting Method Parameters

Seasonal forecasting methods extend the nonseasonal forecasting methods by adding an additional component to capture the seasonal behavior of the data.

Seasonal Additive

Calculates a seasonal index for historical data that does not have a trend. The method produces exponentially smoothed values for the level of the forecast and the seasonal adjustment to the forecast. The seasonal adjustment is added to the forecasted level, producing the seasonal additive forecast.
This method is best for data without trend but with seasonality that does not increase over time. It results in a curved forecast that reproduces the seasonal changes in the data.

**Seasonal Multiplicative**

Calculates a seasonal index for historical data that does not have a trend. The method produces exponentially smoothed values for the level of the forecast and the seasonal adjustment to the forecast. The seasonal adjustment is multiplied by the forecasted level, producing the seasonal multiplicative forecast.

This method is best for data without trend but with seasonality that increases or decreases over time. It results in a curved forecast that reproduces the seasonal changes in the data.

**Holt-Winters’ Additive**

Is an extension of Holt’s exponential smoothing that captures seasonality. This method produces exponentially smoothed values for the level of the forecast, the trend of the forecast, and the seasonal adjustment to the forecast. This seasonal additive method adds the seasonality factor to the trended forecast, producing the Holt-Winters’ additive forecast.

This method is best for data with trend and seasonality that does not increase over time. It results in a curved forecast that shows the seasonal changes in the data.
Holt-Winters’ Multiplicative

Is similar to the Holt-Winters’ additive method. Holt-Winters’ Multiplicative method also calculates exponentially smoothed values for level, trend, and seasonal adjustment to the forecast. This seasonal multiplicative method multiplies the trended forecast by the seasonality, producing the Holt-Winters’ multiplicative forecast.

This method is best for data with trend and with seasonality that increases over time. It results in a curved forecast that reproduces the seasonal changes in the data.

Classic Seasonal Forecasting Method Parameters

The seasonal forecast methods use three smoothing parameters: alpha, beta, and gamma:

- alpha (\( \alpha \)) — Smoothing parameter for the level component of the forecast. The value of alpha can be any number between 0 and 1, not inclusive.
- beta (\( \beta \)) — Smoothing parameter for the trend component of the forecast. The value of beta can be any number between 0 and 1, not inclusive.
- gamma (\( \gamma \)) — Smoothing parameter for the seasonality component of the forecast. The value of gamma can be any number between 0 and 1, not inclusive.

Each seasonal forecasting method uses some or all of these parameters, depending on the forecasting method. For example, the seasonal additive forecasting method does not account for trend, so it does not use the beta parameter.
ARIMA Time-series Forecasting Methods

Autoregressive integrated moving average (ARIMA) forecasting methods were popularized by G. E. P. Box and G. M. Jenkins in the 1970s. These techniques, often called the Box-Jenkins forecasting methodology, have the following steps:

1. Model identification and selection
2. Estimation of autoregressive (AR), integration or differencing (I), and moving average (MA) parameters
3. Model checking

ARIMA is a univariate process. Current values of a data series are correlated with past values in the same series to produce the AR component, also known as $p$. Current values of a random error term are correlated with past values to produce the MA component, $q$. Mean and variance values of current and past data are assumed to be stationary, unchanged over time. If necessary, an I component (symbolized by $d$) is added to correct for a lack of stationarity through differencing.

In a nonseasonal ARIMA($p,d,q$) model, $p$ indicates the number or order of AR terms, $d$ indicates the number or order of differences, and $q$ indicates the number or order of MA terms. The $p$, $d$, and $q$ parameters are integers equal to or greater than 0.

Cyclical or seasonal data values are indicated by a seasonal ARIMA model of the format:

SARIMA($p,d,q$)($P,D,Q$)($t$)

The second group of parameters in parentheses are the seasonal values. Seasonal ARIMA models consider the number of time periods in a cycle. For a year, the number of time periods ($t$) is 12.

Note: In Predictive Planning charts, tables, and reports, seasonal ARIMA models do not include the ($t$) component, although it is still used in calculations.

Predictive Planning ARIMA models do not fit to constant datasets or datasets that can be transformed to constant datasets by nonseasonal or seasonal differencing. Because of that feature, all constant series, or series with absolute regularity such as data representing a straight line or a saw-tooth plot, do not return an ARIMA model fit.

Time-series Forecasting Accuracy Measures

Subtopics

- **RMSE**
- **MAD**
- **MAPE**

One component of every time-series forecast is the data’s random error that is not explained by the forecast formula or by the trend and seasonal patterns. The error is measured by fitting points
for the time periods with historical data and then comparing the fitted points to the historical data.

**RMSE**

RMSE (root mean squared error) is an absolute error measure that squares the deviations to keep the positive and negative deviations from cancelling out one another. This measure also tends to exaggerate large errors, which can help eliminate methods with large errors.

**MAD**

MAD (mean absolute deviation) is an absolute error measure that originally became very popular (in the days before hand-held calculators) because it did not require the calculation of squares or square roots. While it is still fairly reliable and widely used, it is most accurate for normally distributed data.

**MAPE**

MAPE (mean absolute percentage error) is a relative error measure that uses absolute values. The absolute values keep the positive and negative errors from cancelling out each other. Because relative errors do not depend on the scale of the dependent variable, this measure enables you to compare forecast accuracy between differently scaled time-series data.